Guidelines & Requirements for Electronic Theses, Treatises and Dissertations

Revised: January 2014

Prepared by:
The Graduate School
314 Westcott Building
Tallahassee, Florida 32306-1410
www.GradSchool.fsu.edu
# Table of Contents

**QUICK STYLE GUIDE** ................................................................................................................................. 4  
**PREPARING THE MANUSCRIPT** ......................................................................................................................... 5  
  **Introduction** .................................................................................................................................................. 5  
  **Useful Resources** ......................................................................................................................................... 5  
    - ETD Formatting Templates ....................................................................................................................... 5  
    - Manuscript Clearance Advisor ............................................................................................................... 5  
    - Library .................................................................................................................................................... 5  
  **Before You Begin** ........................................................................................................................................ 6  
    - Choosing a Style Guide ........................................................................................................................... 6  
  **Use of Multiple Computers and Software** .................................................................................................. 7  
**MANUSCRIPT FORMATTING REQUIREMENTS** .................................................................................................. 8  
  **General Formatting Requirements** ........................................................................................................... 8  
    - Fonts ........................................................................................................................................................ 8  
    - Line Spacing ........................................................................................................................................ 9  
    - Page Size and Margins ............................................................................................................................ 9  
    - White Space ........................................................................................................................................... 9  
    - Content .................................................................................................................................................... 9  
    - Widows and Orphans ............................................................................................................................... 10  
    - Pagination .......................................................................................................................................... 10  
    - Main Sections ....................................................................................................................................... 10  
    - Colors ................................................................................................................................................ 11  
    - Tables and Figures ............................................................................................................................... 11  
    - Multimedia: Images, Videos, and Sound Files .................................................................................... 12  
    - Hyperlinks ........................................................................................................................................... 13  
    - Arrangement of Contents ...................................................................................................................... 13  
  **Front Matter** .............................................................................................................................................. 14  
    - Title Page ........................................................................................................................................ 14  
    - Committee Page ................................................................................................................................. 14  
    - Dedication ........................................................................................................................................ 14  
    - Acknowledgments ............................................................................................................................... 14  
    - Table of Contents ............................................................................................................................... 15  
    - List of Tables, Figures, and Musical Examples .................................................................................... 15  
    - Abstract .......................................................................................................................................... 16  
  **Body of Manuscript** ................................................................................................................................... 16  
    - Subheadings ..................................................................................................................................... 16  
  **Back Matter** ............................................................................................................................................. 16  
    - Appendix/Appendices .......................................................................................................................... 16  
  **Copyright Permission Letters** .................................................................................................................... 17  
**Human and Animal Subjects Approval** ........................................................................................................... 17  
  - References, Bibliography, Literature/Works Cited .................................................................................. 18  
  - Biographical Sketch .............................................................................................................................. 18  
**LaTeX Documents** ....................................................................................................................................... 18  
**THE UPLOADING PROCESS** ............................................................................................................................ 20  
  **Publication Type** .................................................................................................................................... 20  
    - Traditional ........................................................................................................................................ 20
QUICK STYLE GUIDE

This page is a quick reference to some of the important manuscript formatting criteria. This is not a comprehensive list and all criteria listed elsewhere in the manual still apply.

Page Size – 8.5" x 11"
Page Margins – 1 inch on left, right, bottom, top; no exceptions.
Fonts – The entire manuscript must be the same font, and all font must be black; see page 8 for acceptable fonts and font sizes. Font size of the main section headings may be up to 2 points larger than the body text but not larger than 14 pt.

Line Spacing – Text from the Abstract through the Biographical Sketch must be all double-spaced or all 1.5 spaced. Exceptions: table headings and figure captions; entries in the references section, and List of Tables, Figures or Musical Examples; block quotations; and a résumé or CV in the Biographical Sketch. See the corresponding sections for details.

White Space – Fill pages with text, tables, and/or figures so that there is no more than a 1-inch block of continuous white space on a page. Exceptions: last page of a chapter or appendix, or where orphan/widow is avoided (see page 10).

Page Numbering – Page numbers must be bottom-center. The front matter must be lower-case Roman numerals, beginning with ii on the committee page. The title page is not numbered but is counted as page i. The body of the manuscript and back matter are numbered consecutively with Arabic numerals beginning with 1 on the first page after the Abstract. Running heads with the title of the manuscript or student’s name are not permitted.

Main Sections – All main section headings must be consistent with each other, using the same font type, font size, and bold or unbolded. All main section headings must be top-center and all capital letters.

Tables and Figures – Table headings go above the table, and figure captions go beneath the figures. All captions and headings must be unique. Tables and figures should be separated from any text on the page by 2 blank lines of space above and below the table or figure.

References – There must be a comprehensive references section at the end of the manuscript; references at the end of individual chapters are not permitted. Entries must be single-spaced with a single blank line between each entry. You may use the format style preferred in your discipline concerning numbering, alphabetizing or the format of the entry itself.

Personal Information – There must not be any personal contact information or signatures within the manuscript. Please delete, obscure or redact any personal contact information or signatures that may be included. This may include, but is not limited to, IRB approval memos, consent forms, copyright permission letters and the biographical sketch.

Please Note
• The student and their committee are ultimately responsible for the quality of the work produced.
• Consistency is key to a successfully formatted document. Make sure that all style decisions are consistently used throughout the document.
• This is a professional document – present your very best.
• Once the manuscript has been accepted by The Graduate School, no changes can be made to the document. Make sure that all proofreading and editing has been done thoroughly before final submission.
PREPARING THE MANUSCRIPT

Introduction

The purpose of this publication is to provide all Florida State graduate students writing a thesis, treatise or dissertation with the Graduate School manuscript requirements necessary for graduation. These requirements have been designed with the knowledge that publication norms can vary dramatically by field of study. While students are encouraged to choose a style guide approved or recommended by their department, specifications in the *Guidelines and Requirements for Electronic Theses, Treatises, and Dissertations* take precedence over all other manuals and style sheets. Students are expected to electronically submit their manuscript through the ETD Administration site ([www.etdadmin.com/fsu](http://www.etdadmin.com/fsu)) 4 weeks (doctoral) or 2 weeks (masters) prior to their defense date, or at the same time they submit the manuscript to committee members for review if earlier than that.

Manuscripts not formatted in full accordance with the Guidelines brochure will NOT be reviewed and will NOT count as an initial submission to meet any deadline.

Limitations of software packages are not valid reasons for granting exceptions to the requirements in the *Guidelines and Requirements for Electronic Theses, Treatises, and Dissertations*.

Useful Resources

ETD Formatting Templates

Electronic templates have been created and formatted according to the requirements outlined in the *Guidelines and Requirements for Electronic Theses, Treatises, and Dissertations*. These templates are located in GradSpace, The Graduate School’s Blackboard® site, under the “Manuscript Clearance” submenu. Currently there are templates for Word (compatible with versions 2007 and 2010) as well as LaTeX.

Manuscript Clearance Advisor

The Manuscript Clearance Advisor provides assistance to students and departments for issues related to the manuscript clearance process. You may contact the Advisor by phone or email (850-644-0045; clearance@fsu.edu), or by stopping by the office in 314 Westcott Building.

Library

University Libraries offer support for Graduate Students in several ways. Research librarians and departmental liaisons are readily available for research assistance. Additionally, the library is building expertise in the area of scholarly communication and publishing. The Scholarly Communications Librarian is available for consultation regarding the use of copyrighted material in ETDs (Fair Use), understanding your own copyrights to your thesis or dissertation, information about access options for your manuscript, reading and interpreting journal publishing contracts, use and re-use of your previously published materials, open access and its
Before You Begin

Choosing a Style Guide

Because various disciplines use different style manuals, Florida State University does not sanction any one footnote, bibliography, or format convention over another. The student and the major professor are responsible for adhering to college and departmental models. The Manuscript Clearance Advisor is responsible for adhering only to university-wide requirements, and will not comment on the requirements of specific style manuals.

Regardless of the style manual being followed, there are certain standard requirements for the manuscript. Those requirements are:

- Specifications in this document take precedence over style manual guidelines.
- An Acknowledgment section, while optional, only may be placed in the preliminary pages and covers any acknowledgment for the entire manuscript. There should not be additional acknowledgments at the beginning of subsequent chapters.
- There must be a common Table of Contents covering the entire manuscript as well as a common List of Figures and List of Tables. If there is only one table or figure within the manuscript do not include a list for it. Music students may be required to include a List of Musical Examples. The List of Figures, Tables, or Musical Examples must include any figure, table, or musical example in an appendix.
- An abstract of the complete study must be placed in the preliminary pages of the manuscript. This abstract must cover the entire manuscript. There should not be additional abstracts at the beginning of subsequent chapters. *Although there is no maximum length for the abstract, it is recommended by ProQuest that the abstract not exceed 750 words.*
- Chapters must be formatted congruently, including manuscripts in which one or more chapters have been published. In cases where some chapters have been published, the student shall include an introductory paragraph stating details about the publication.
- If each chapter or section is complete within itself, for instance, a manuscript composed of separate articles, a general introduction to the entire manuscript must be placed at the beginning of the document as well as a final chapter stating conclusions and total results.
- A comprehensive Bibliography or References must be placed at the end of the manuscript. References may not be put at the end of each chapter.
- Figures and tables must be numbered consecutively throughout the manuscript (1, 2, 3, etc.) or linked with the chapters and appendices (1.1, 1.2, 1.3, 2.1, 2.2, 2.3, etc.). Tables and figures in the appendix should be numbered appropriately in accordance with the other tables and figures in the text.
Some standard style guides include:

- *The Chicago Manual of Style.*
- Kate L. Turabian. *A Manual for Writers of Term Papers, Theses, and Dissertations.*

**Use of Multiple Computers and Software**

The Graduate School strongly advises against the use of multiple computers and software when drafting the manuscript, as this may cause irreparable mistakes in the electronic submission.
MANUSCRIPT FORMATTING REQUIREMENTS

General Formatting Requirements

*** All manuscripts must be formatted according to specifications in this manual unless the student’s department has requested and received from the Manuscript Clearance Advisor an exemption based on discipline-specific practices. ***

Fonts

The entire text of the manuscript must be in the same font; all text should be black font. Use a TrueType font, NOT a scalable font. During the ETD submission process WORD documents are converted to PDF format. Using a TrueType font will ensure that your manuscript looks the same in PDF format as it does in WORD. Recommended TrueType fonts and point sizes are listed below. Smaller fonts like Times New Roman should be set at 12-point, while larger fonts such as Courier should be set at 10-point.

<table>
<thead>
<tr>
<th>Font</th>
<th>Point Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arial</td>
<td>10pt</td>
</tr>
<tr>
<td>Century</td>
<td>11pt</td>
</tr>
<tr>
<td>Courier New</td>
<td>10pt</td>
</tr>
<tr>
<td>Garamond</td>
<td>12pt</td>
</tr>
<tr>
<td>Georgia</td>
<td>11pt</td>
</tr>
<tr>
<td>Lucida Bright</td>
<td>10pt</td>
</tr>
<tr>
<td>Microsoft Sans Serif</td>
<td>10pt</td>
</tr>
<tr>
<td>Tahoma</td>
<td>10pt</td>
</tr>
<tr>
<td>Times New Roman</td>
<td>12pt</td>
</tr>
<tr>
<td>Trebuchet MS</td>
<td>10pt</td>
</tr>
<tr>
<td>Verdana</td>
<td>10pt</td>
</tr>
</tbody>
</table>

If desired, main section headings and chapter and appendix titles may be up to 2 pt larger than the font in the body of the text; however font size of headings and titles must not exceed 14 pt. Boldface, underline, and italics may be used where appropriate. The only exception is for LaTeX manuscripts (see page 18 for more information about LaTeX manuscripts). However, all main section headings must be formatted congruently, as must all chapter and appendix titles.

If necessary, a different font may be used for tables and figures as well as appendix material. All items must be clear and readable. Items that do not reproduce well must be re-typed, and you must clearly indicate in the heading or caption that the retyped item is a transcription.

Some fonts and special characters do not convert well to the PDF format; allow time to solve such problems.
Line Spacing

Text in the Abstract through the Biographical Sketch must be all double-spaced or all 1.5 spaced. In the WORD Paragraph menu, make sure spacing Before and After is set to zero. The only line spacing exceptions are: table headings and figure captions; entries in the references section, and List of Tables, Figures or Musical Examples; block quotations; and a résumé or CV in the Biographical Sketch.

Page Size and Margins

Page size for the entire manuscript must by 8 1/2 x 11 inches. One inch margins are to be used on all four sides, with 1/2 to 3/4-inch margins to the page numbers.

White Space

In the body of the manuscript and the Appendices, fill pages with text, tables, and/or figures to ensure that there is no continuous block of white space greater than 1 inch inside the top or bottom margins, or between text, tables, and/or figures. In some cases figures and tables may need to be slightly reduced in size, or text from subsequent pages may have to be moved to fill pages. White space may exceed 1 inch on the last page of a Chapter or an Appendix.

Content

All content should start at the top margin of the page – text, tables, and figures. To start at the top margin of a new page:

- MS WORD – press Ctrl+Enter
- Mac version of WORD – select "Insert" on the top menu, then "Break" and "Page Break".

![Image of Word Page Break menu]
Widows and Orphans

A widow is the last line of a paragraph that appears at the top of a new page. An orphan is the first line of a paragraph that begins at the bottom of a new page and is separated from the remainder of the paragraph. **Widows and orphans should be avoided.**

In WORD:

To control widow and orphan lines:
1. Select the paragraphs in which you want to control widows and orphans.
2. On the Format menu, click Paragraph, and then click the Line and Page Breaks tab.
3. Select the Widow/Orphan control check box.

To keep lines of a paragraph together on a page:
1. Select the paragraphs that contain lines you want to keep together.
2. On the Format menu, click Paragraph, and then click the Line and Page Breaks tab.
3. Select the Keep lines together check box.

In LaTeX, the template available in the Manuscript Clearance menu of GradSpace incorporates widow/orphan control.

Do not insert a new subheading at the bottom of a page unless the subsection includes two or more lines of text.

Pagination

All page numbers must be placed bottom-center. The front matter (i.e., preliminary pages) must be numbered with lower-case Roman numerals (ii, iii, iv, etc.). **Do not number the title page.**
The first numbered page will be the Committee page, and it will be page ii. The body of the manuscript and back matter are numbered consecutively with Arabic numerals (1, 2, 3, etc.).
The first page of the body is page number 1. The number should be used by itself. Neither dashes (-10-) nor the word “page” can be used. Headings with the student’s name or the title of the manuscript, known as running heads, are not permitted.

Main Sections

The main sections of a manuscript are listed below. Each main section must have a heading that is centered at the top margin of a new page (see Content, page 9), all capital letters, and may be bold-faced if desired. All main section headings must be formatted congruently. For instance, if one heading is bold-faced, all must be bold.

- ACKNOWLEDGMENTS
- TABLE OF CONTENTS
- LIST OF TABLES, LIST OF FIGURES, LIST OF MUSICAL EXAMPLES
- ABSTRACT
• CHAPTER 1, 2, etc…
• APPENDIX A, B, etc…
• BIBLIOGRAPHY/REFERENCES/LITERATURE CITED
• BIOGRAPHICAL SKETCH

**Chapters.** Be consistent when naming/numbering chapter headings. If the first chapter uses the convention “CHAPTER 1”, then subsequent chapters should be named “CHAPTER 2”, “CHAPTER 3”, etc. (minus the quotes). Likewise, if the first chapter uses the convention “CHAPTER ONE”, then subsequent chapters should be named “CHAPTER TWO”, “CHAPTER THREE”, etc. Do not use Roman numerals as chapter numbers.

Chapter titles are centered below the chapter headings. Titles must be all capital letters and the same font face as the headings; however, you may italicize any Latin names or titles of artistic works, and follow standard scientific nomenclature rules regarding capitalization. The spacing between the chapter heading and chapter title should be double-spaced. For titles on more than one line, text should be single-spaced. Line spacing of the chapter headings/titles must be consistent throughout the entire manuscript.

No more than two single blank lines should be left between chapter titles and the text; this spacing must be consistent throughout the manuscript.

**Colors**

Colors in tables and figures will appear as shades of gray for paper copies printed in black-and-white. When printed in black-and-white green reproduces faintly, and light blue, not at all.

**Tables and Figures**

The word “table” designates any tabulated data while the word “figure” designates all other non-verbal material such as illustrations, graphs, maps, photographs, drawings, and diagrams. All tables and figures must be of reproducible quality. Poor reproductions should be retyped or redrawn below the material or on the following page. The student must indicate that the typed or redrawn material is a transcription of the original. This rule also applies to material in the appendices.

All tables and figures in the body of the manuscript and the appendices must be numbered. Tables and figures may be numbered consecutively throughout the text (1, 2, 3, 4, etc.) or linked with the chapters (1.1, 1.2, 2.1, 2.2, A.1, B.1, etc.). Tables and figures in the appendices should be numbered appropriately in accordance with the other tables and figures in the text.

Each table must have a unique heading and each figure a unique caption. Table headings always go above the table, and figure captions always go below the figure. Headings and captions must be single-spaced and located on the same page as the table or figure. Table and figure captions must be the same size font and style throughout the manuscript. This font and style does not have to be the same font and style as the body of the text in the manuscript.
When possible, figures and tables should be integrated into the text as they are discussed; however, the specification about white space (see page 8) should be adhered to. Do not put a statement in the text like “Insert Table 2 here”. The table (or figure) should be inserted directly at that point or put on the following page. If the student’s committee feels it is necessary to group the illustrations together, they may be placed together at the end of the chapter or in one or more appendices. Tables and figures may appear on the same page with text or if they fill the entire page, they may appear on separate pages. When text is used on the same page, it must be separated from the table or figure by two blank lines above and two blank lines below the table or figure. For tables, the two blank lines will go above table headings and below the table. For figures, the two blank lines will go above the figure and below the figure caption.

Two or more small tables or figures should be grouped on a single page to fill the page.

Tables and figures too large for one page, may be slightly reduced, oriented landscape, or continued on the next page.

If a table continues onto the next page, “Table # - continued” (minus the quotes) must be placed at the top of the next page above the continued table. It is important to ensure that “Table # - continued” is placed within the proper margins of the document. Also, column and row headings must be repeated for each portion of a continued table.

In WORD, you will need to create a separate table for the continued portion of the table otherwise there will be no blank line in which to insert the table number. At the top of the page, press the ENTER key to create a blank line where you will insert the table number. Insert the ”new” table on the second line.

If a figure spans more than page, place the entire caption underneath the figure on the first page, and just “Figure # - continued” (minus the quotes) underneath the figure on subsequent pages.

**Multimedia: Images, Videos, and Sound Files**

Students are permitted (and encouraged) to include image, video, or sound files as part of the manuscript. While ProQuest will accept multimedia content of all file types, file types other than those listed below are not guaranteed to be migrated.

- Images: GIF (.gif); JPEG (.jpeg); TIFF (.tif)
- Video: Apple Quick Time (.mov); Microsoft Audio Video Interleaved (.avi); MPEG (.mpg)
- Audio: AIF (.aif); CD-DA; CD-ROM/XA; MIDI (.mid); MPEG-2; SND (.snd); WAV (.wav)

Submit audio, video, and spreadsheets that are part of your dissertation, treatise, or thesis as supplementary files during the online submission process. **Do not embed media files in your manuscript.** Provide a description of each supplementary file or files only in the abstract of your online ProQuest ETD account.
Hyperlinks

Web sites should not be blue, underlined, or contain an active hyperlink. To disable automatic hyperlinking in WORD:

WORD 2010
1. On the File menu, click Options.
2. Click Proofing, and then click AutoCorrect Options.
3. On the AutoFormat as you type tab and on the AutoFormat tab, click to clear the Internet and network paths with hyperlinks check box, and then click OK.
4. Click OK to close the Word Options dialog box.

WORD 2007
1. Click the Microsoft Office Button, and then click Word Options.
2. Click Proofing, and then click AutoCorrect Options.
3. On the AutoFormat as you type tab and on the AutoFormat tab, click to clear the Internet and network paths with hyperlinks check box, and then click OK.
4. Click OK to close the Word Options dialog box.

Arrangement of Contents

<table>
<thead>
<tr>
<th>SECTION</th>
<th>REQUIRED OR OPTIONAL</th>
<th>PAGE NUMBERING</th>
</tr>
</thead>
<tbody>
<tr>
<td>TITLE PAGE</td>
<td>REQUIRED</td>
<td>No page #</td>
</tr>
<tr>
<td>COMMITTEE PAGE</td>
<td>REQUIRED</td>
<td>Lower case Roman numeral (p. ii)</td>
</tr>
<tr>
<td>DEDICATION</td>
<td>Optional (no heading)</td>
<td>Lower case Roman numeral</td>
</tr>
<tr>
<td>ACKNOWLEDGEMENTS</td>
<td>Optional</td>
<td>Lower case Roman numeral</td>
</tr>
<tr>
<td>TABLE OF CONTENTS</td>
<td>REQUIRED</td>
<td>Lower case Roman numeral</td>
</tr>
<tr>
<td>LIST OF TABLES</td>
<td>REQUIRED¹</td>
<td>Lower case Roman numeral</td>
</tr>
<tr>
<td>LIST OF FIGURES</td>
<td>REQUIRED²</td>
<td>Lower case Roman numeral</td>
</tr>
<tr>
<td>ABSTRACT</td>
<td>REQUIRED</td>
<td>Lower case Roman numeral</td>
</tr>
<tr>
<td>MAIN BODY</td>
<td>REQUIRED</td>
<td>Arabic numerals (1, 2, 3…)</td>
</tr>
<tr>
<td>APPENDICES</td>
<td>Optional³</td>
<td>Arabic numerals</td>
</tr>
<tr>
<td>REFERENCES</td>
<td>REQUIRED</td>
<td>Arabic numerals</td>
</tr>
<tr>
<td>BIOGRAPHICAL SKETCH</td>
<td>REQUIRED</td>
<td>Arabic numerals</td>
</tr>
</tbody>
</table>

¹ Include only if there is more than one table.
² Include only if there is more than one figure.
³ Must include if human or animal subjects approval was required for the research or if a copyright approval letter is required. See page 17.
Front Matter

The front matter (preliminary pages) of a manuscript begins with the title page and extends to the abstract; all pages except the title page are numbered with lower-case Roman numerals.

Title Page

The title page is the first page of a manuscript; however, the page number is omitted. See the Appendix for formatting of the Title Page. Also,

- The title should be a concise statement that accurately describes the main topic of the research. Its length should not exceed four lines of text, or 15 words, whichever is less. Font size may not be reduced to meet this requirement.
- If the title consists of more than one line of text, break the lines so that the lines are approximately the same length. Additionally, there should be a single blank line between the lines of text.
- In the title, *italicize* any Latin names or titles of artistic works, follow standard scientific nomenclature rules regarding capitalization, and spell out any chemical names.
- The font size on the title page must be the same as font size in the remainder of the manuscript (see **Fonts**, page 8).

Committee Page

Committee members with their correct roles and the defense date must be listed on the second page of the manuscript. If two major professors are directing a student’s thesis, treatise or dissertation, both major professors must be listed at the top of the Committee Page, with the title of “Professor Co-Directing Thesis/Treatise/Dissertation” (without quotes) underneath the name. Do not include the title (e.g., Dr. or PhD) of any committee member. The committee members and their roles must exactly concur with the committee members and their roles listed in the Graduate Student Tracking database as well as any required forms. All manuscript forms are located in the Manuscript Clearance submenu of GradSpace. See the Appendix for formatting of the Committee Page.

Dedication

This optional section pays special tribute to people who have given extraordinary support or encouragement to the student’s academic career. Extravagant praise, insincere thanks and references to animals or inanimate objects are unacceptable. The text should be brief, and centered horizontally and vertically on the page. This page does not have a main section heading.

Acknowledgments

This optional section thanks those who have helped the student obtain the graduate degree, including those who have provided grants and special funding for research. The student also may acknowledge those who gave permission to include copyrighted material in the manuscript.
Extravagant praise, insincere thanks and references to animals or inanimate objects are unacceptable. This is the first section with a main section heading.

Table of Contents

There must be a common Table of Contents covering the entire manuscript. The Table of Contents must meet the following formatting requirements:

- Major sections must be included. Subheadings can be included, but are not required.
- Headings and subheadings must exactly concur, word-for-word as well as capitalization and punctuation, with the headings in the body of the manuscript.
- Alignment and spacing of entries must be consistent.
- Every entry must have a page number.
- The page number for each entry must be right-justified at the right margin; the use of leading dots is strongly encouraged.

In WORD:
1. On the Format menu, select Paragraph
2. In the Paragraph menu, select Tabs
3. In the Tabs menu
   Tab stop position – enter 6.5
   Alignment – Right
   Leader – 2…..
   Then click Set; then click OK

- Use of an automatic Table of Contents generator does not supersede any of the formatting requirements listed above. For those using WORD, only advanced users should consider using an automatic Table of Contents generator.

List of Tables, Figures, and Musical Examples

A common List of Tables, Figures, or Musical Examples is required only when there are two or more tables, figures, or musical examples in the manuscript, including the appendices. Each type of list must start at the top of a new page. Items included in the appendices also must be included in the lists. All lists must meet the following formatting requirements:

- Headings and captions must exactly concur, word-for-word as well as capitalization and punctuation, with the headings and captions in the body of the document. For long headings and captions, just the entire first sentence is required; however, the use of just the entire first sentence in a particular List must be used throughout that entire List.
- Entries must be single-spaced, with a single blank line between entries.
- Entries must have page numbers, which must be right justified; the use of leading dots is strongly encouraged. Refer to the section on Table of Contents (above) for instructions on how to right justify page numbers in WORD.
Abstract

An abstract of the complete study is required and is the last section of the front matter. It is a succinct statement of the significant contents of the manuscript and the value and relevance of the study. Generally, it should be no longer than 750 words; however, it can be longer if absolutely necessary. Additional abstracts at the beginning of subsequent chapters are not permitted.

Body of Manuscript

The body of the manuscript includes all chapters. The body may be formatted in any accepted, discipline-specific style or according to an approved style guide, but with the restrictions listed below. Additionally, there should be no blank pages in the manuscript. REFER TO THE TEMPLATES IN THE MANUSCRIPT CLEARANCE SUBMENU OF GRADSPACE.

- Text of the body must begin on page 1.
- Chapter headings (for example Chapter One, Chapter Two, etc.), which are main section headings, must be consistent with all other main section headings in the manuscript.
- Spacing around headings, tables, figures and other elements should be consistent throughout the manuscript.

Subheadings

Subheadings should follow the convention of your discipline but must be consistent throughout the body of the manuscript.

Back Matter

The back matter of your manuscript includes the Appendices, References, and Biographical Sketch.

Appendix/Appendices

An appendix is for information that is too detailed for the body of the manuscript or is indirectly related to the text; it may include tables, figures, musical examples and computer programs. The appendix also is where the student must include any approvals for the use of human or animal subjects in the research, any sample informed consent form, and any copyright permission letters.

If there are several categories of supplementary material, more than one appendix will be necessary. Appendices are designated using the following heading sequence: APPENDIX A, APPENDIX B, APPENDIX C, etc., with a title centered under each heading. There should not be a separate appendix “title page” placed before the first appendix. Appendix headings and titles must be formatted exactly the same as main section headings and titles.
Every page must be clear and legible. If a poor copy must be included, then a transcription below the material or on the following page must be given, with a clear indication that it is a transcription.

Figures and tables in the appendices should be numbered consistently with the other figures and tables in the text. If they are numbered consecutively in the text, then the numbering should be continued in the appendices. For example, if the last table in the text is labeled “Table 21”, then the first table in the appendices would be “Table 22”. If the numbering sequence is coded to the chapter number (1.1, 1.2, 2.1, 2.2, etc.), then that pattern should be continued with the material in the appendices (A.1, A.2, B.1, B.2, etc.).

Entries for each appendix are listed in the Table of Contents under the heading Appendix, or Appendices if more than one, with each entry comprised of the appendix letter followed by the title exactly as it appears in the manuscript.

**Copyright Permission Letters**

Reprint Permission Letters: If including multimedia material covered under someone else's copyright – an audio or video clip, digital image, figure or tables from a journal article or book, etc. – the student must provide ProQuest/UMI with written permission to include it. In addition, the Graduate School requires that a permission letter be placed in the appendix for any copyrighted material included in the manuscript. A Copyright Approval Form template is in the Resources directory under the Manuscript Clearance submenu in GradSpace. Other copyright issue resources are available in that directory as well. If copyright permission is not needed, the student should state in an email to the Clearance Advisor that the item in question is Fair Use.

To determine if including copyrighted material is Fair Use, consult FSU’s Fair Use Evaluator and Research Guide [http://guides.lib.fsu.edu/content.php?pid=73946&sid=558766](http://guides.lib.fsu.edu/content.php?pid=73946&sid=558766).

Third Party Software Licenses: If including third party software as part of the submission, the student must provide ProQuest/UMI written permission to distribute it. Note that this is different than including a file generated by a particular program, e.g., including a copy of Microsoft Excel is different than including an .xls file generated in Excel. A software license is not needed to include an .xls file.

**Human and Animal Subjects Approval**

Research involving human subjects requires Florida State Human Subjects Committee Approval (IRB). The Florida State Human Subjects Committee Approval Letter and a sample of the Informed Consent Letter must be placed in the appendices of the manuscript. Likewise, research involving vertebrate animals requires animal subject approval (IACUC). The student must include the Florida State Animal Subjects Committee approval letter within the appendices. In either case, the student’s name must appear on the Approval Form, and the Approval Form must cover the period when the research was conducted. Be sure to remove personal contact information from any approval letter or informed consent form as these may change over time and should not be a part of the permanent record. Situations in which a student fails to meet either of these requirements are resolved on a case-by-case basis and could have serious
consequences up to and including the manuscript being permanently embargoed and unpublishable by any and all parties.

References, Bibliography, Literature/Works Cited

A comprehensive bibliography or references list is placed at the end of the manuscript. References may not be put at the end of each chapter. Complete bibliographical notation is extremely important and required.

The style manual chosen will dictate whether this section is titled Bibliography, Literature Cited, Works Cited, or References. The style should be the same as the major journals in the student’s discipline. If not sure which style to use, the student should consult the major professor. Regardless of the style, the following format is required:

- Entries must be single-spaced, with a single blank line between entries.
- Web sites must not be blue, underlined, or contain an active hyperlink (see page 13).
- Entries should not be split between pages. If an entire entry does not fit at the bottom of one page, move the entire entry to the top of the next page.

Biographical Sketch

A brief Biographical Sketch, which is required and the last section of the manuscript, is a summary of the student’s educational and professional experience. It may be in vita/résumé format, or paragraph format. If in paragraph format the text and line spacing must be the same as in the body of the text. Do not include personal contact information as it is subject to change over time.

LaTeX Documents

If using LaTeX, you are strongly encouraged to use the FSU LaTeX template. The template and user guide are in a single zipped file that can be downloaded from the Formatting Guidelines and Support folder under the Manuscript Clearance submenu of GradSpace.

When using LaTeX:

1. Avoid the use of:
   - Linking boxes
   - Blue font that link sections
   - Green font that link references
2. Be sure that the page margins on all four sides are 1 inch.
3. It is suggested that you NOT tweak the FSU template.
4. Some programs associated with LaTeX may cause uploading issues; please allow time to address such issues.
5. Be aware that LaTeX documents must be converted to PDF format before being uploaded to the ETD website. See page 21 for information about converting a LaTeX document to a PDF.
THE UPLOADING PROCESS

Before uploading your manuscript, please read about the uploading process so that you understand the process and decisions to be made. Once you understand the process and are ready to submit, you can start the upload process by going to the ProQuest/UMI site at www.etdadmin.com/fsu and clicking on "Submit my dissertation/thesis". Directions are provided as you progress through the screens on the ProQuest/UMI site.

Publication Type

There will be two publication type options to select from, Traditional and Open Access. After that there will be an option to restrict manuscript access (embargo).

Traditional

This option suits the needs of most students. There is no fee for this option, and it allows the student to receive royalties on copies sold by ProQuest/UMI (see page 21).

Open Access

Open Access manuscripts can be viewed and downloaded for free from the ProQuest/UMI site. However, the student must pay a fee to ProQuest/UMI for this service. When making this decision, keep in mind that manuscripts that are not embargoed (see below) can be viewed and downloaded for free via the Florida State University Libraries.

Publishing Restrictions (Embargoes)

After selecting a publication option, the next decision will be about publishing restrictions (embargoes). The major professor should be consulted to assist the student in deciding whether an embargo is warranted. The Graduate School permits proprietary issue-based embargoes of 24 months on student manuscripts. However, the embargo must be approved by the Dean of the Graduate School. A student may elect to have their manuscript permanently embargoed on the ProQuest/UMI site; in such cases the student must request “campus-only access” for the copy of their manuscript posted by the Florida State University Library. Contact the Manuscript Clearance Advisor at clearance@fsu.edu for information about the appropriate steps for pursuing an embargo.

Bound Copies

ProQuest/UMI offers several binding options. Copies can be ordered when the manuscript is uploaded or after graduation for the same price. Receipt of the bound copies may take several months after the end of the semester. Any questions or concerns about the printing of purchased copies should be directed to ProQuest/UMI. Florida State University has no control over this part of the process.
Royalties

Each student who submits a manuscript on ProQuest/UMI is giving ProQuest/UMI non-exclusive rights to offer copies for sale. Students selecting the traditional publishing option whose manuscripts are sold through ProQuest/UMI receive royalty payments.

Italics in Title

If entering italicized text in the manuscripts title field (foreign words or scientific names), use HTML tags to do so. To use these tags, insert "<i>" in front of the word to be italicized and "</i>" after the word. It will look like this: "The title of my manuscript has an <i>italic</i> word in it." The actual print out will look like this: "The title of my manuscript has an italic word in it."

Converting Your Manuscript to PDF Format

All manuscripts in ProQuest are PDF documents. Students may upload a PDF version of their manuscript, or upload a WORD version which ProQuest converts to PDF.

WORD Documents

This guidance assumes you are writing your manuscript in MS Word on a PC. If you are using a Mac, similar guidance can be found in the help files on the ProQuest/UMI site. The ETD submission interface will convert an MS WORD file to PDF format. To ensure that your manuscript looks the same in PDF format as it does in the WORD version, the fonts in the WORD document must be embedded. To embed your fonts in the WORD document:

1. Create your manuscript using a TrueType font, NOT a scalable font.
2. On the Tools menu, click Options, and then click the Save tab.
3. Select the Embed TrueType font check box.
4. Save the document.

LaTeX Documents

If your manuscript was written in LaTeX and you have access to Adobe Acrobat Standard or Professional, simply generate a .prn file of your LaTeX file and use Acrobat to convert it to PDF. If you do not have access to Adobe Acrobat, there are several online resources that will help you to convert your file to PDF using the dvips - Ppdf driver included in many distributions of LaTeX.

Manuscripts Needing Revision

If revisions are required by the Manuscript Clearance Office, you will need to make those revisions, convert, upload and wait for a response. This process will be repeated until your manuscript is accepted. Most manuscripts are revised at least once, so allow time to revise your manuscript in order to meet the semester or 60-day deadline. Please do not create a new account for submitting revised manuscripts.
Manuscripts are cleared after the Manuscript Clearance Advisor has approved formatting of the manuscripts, and received and verified all signed forms.

The manuscript clearance process must be completed no later than the final submission deadline each semester, or the 60-Day Deadline, whichever is earliest. Semester clearance deadlines are posted in the Manuscript Clearance submenu of GradSpace.

**60-Day Deadline** – Manuscripts must be cleared (manuscript formatting approved, and all forms received) no later than 60 days after the date of a successful defense. If a manuscript is not cleared within 60 days of the defense, the student must re-defend – no exceptions. This rule applies even if a student does not graduate in the semester in which the student's defense was held. For example, a student defending on 12/6/13 would graduate Spring 2014 but the manuscript would have to be cleared by 2/6/14, about 2 months before the semester final submission deadline in April.

**Accepted Manuscripts**

If your manuscript has been cleared, you have finished. CONGRATULATIONS! You will receive the fireworks email to confirm your completion.

Please note that after the manuscript formatting is approved and all forms are received, the submission is locked and NO further changes will be allowed.
APPENDIX

TITLE AND COMMITTEE PAGES
John Q. Public defended this thesis on February 14, 2014.

The members of the supervisory committee were:

James B. Rainiac
Professor Directing Thesis

Hope S. Eternel
Committee Member

Gustov Wind
Committee Member

The Graduate School has verified and approved the above-named committee members, and certifies that the thesis has been approved in accordance with university requirements.
FLORIDA STATE UNIVERSITY

COLLEGE OF ARTS AND SCIENCES

JOE AMOEBA AND THE PROTOZOA

AND OTHER ODDITIES

By

JOHN Q. PUBLIC

A Dissertation submitted to the
Department of English
in partial fulfillment of the
requirements for the degree of
Doctor of Philosophy

Degree Awarded:
Summer Semester, 2014

© 2013 John Q. Public
John Q. Public defended this dissertation on February 14, 2014.
The members of the supervisory committee were:

James B. Rainiac  
Professor Directing Dissertation

Gale F. Winde  
University Representative

Mary Smiley  
Committee Member

Hope S. Eternel  
Committee Member

The Graduate School has verified and approved the above-named committee members, and certifies that the dissertation has been approved in accordance with university requirements.